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Einführung 
Was ist DxNode.Net ? 

 DxNode.Net ist eine komplette, lauffähige Software die als so genannte Knoten (Node) in den 
beteiligten Systemen installiert wird. Die einzelnen Knoten sind beliebig vernetzbar - auch über 
Internet - und bilden zusammen das Netzwerk (Net) für den Datenaustausch (Data eXchange) 
zwischen den Systemen 

 Die Ankopplung wie auch der Datenaustausch zwischen DxNode erfolgt über ein einziges Protokoll, 
das auf den internationalen Standards TCP/IP (Transport), XML (Datendarstellung) und Web-
Services (Internet) basiert und mit XSD (XML Schema) dokumentiert ist. Die Konfiguration ist 
ebenfalls XML basiert und kann mit dem selben XML Schema geprüft werden 

 DxNode.Net unterstützt OPC Client und Server Schnittstellen sowie weitere nützliche Funktionen wie 
Speichern und Weiterleiten von Daten (Store&Forward), mehrfach redundante Ankopplungen, 
Datenverschlüsselung (Encryption) u.a.m. 

 DxNode.Net ist eine offene, neutrale Kommunikationsschicht (Middleware), die den Anwender 
unabhängig von Herstellervorgaben macht. Die Software ist verfügbar für Linux und Microsoft 
Windows Plattformen. Das Netzwerk bildet eine Art verteilte Datenbank, jede Anlage kann mit jeder 
anderen Anlage Daten austauschen, auch mit OPC und über Internet: 
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Was ist DxMonitor ? 
 DxMonitor ist ein Beobachtungs- und Test-Tool für DxNode.Net. Das Tool ermöglicht die 

Visualisierung von Datenpunkten eines DxNode Knotens in Tabellenform. Mehrere Knoten können in 
unabhängigen Tabellen auf dem gleichen Rechner (z.B. Laptop) dargestellt werden. 

 Ausgewählte Datenpunkte werden in Echtzeit mit den dynamischen Attributen am Bildschirm 
dargestellt. Auswählbare Telegrammtypen von beliebigen Verbindungen können in 
chronologischer Reihenfolge in XML Log-Dateien aufgezeichnet werden. Die Telegramme können in 
Echtzeit gegen ein XML-Schema validiert werden. Auf diese Weise lassen sich einzelne oder 
mehrere Verbindungen jederzeit überwachen und prüfen. 
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Grundlagen 
DxMonitor ermöglicht die Visualisierung und Beobachtung von Datenpunkten eines Knotens (DxNode) 
innerhalb von DxNode.Net. Die Attribute ausgewählter Datenpunkte werden in Echtzeit am Bildschirm 
dargestellt. Ausserdem kann ein Logfile erstellt werden, um auswählbare Telegrammtypen in 
chronologischer Reihenfolge aufzuzeichnen. Die zu loggenden Telegramme können zur Laufzeit gegen ein 
XML-Schema validiert werden. 
 

 
 
 
 
 
 
 
Das Programm kann auf einem Knotenrechner selbst, oder auf einem eigenständigen Rechner (z.B. 
Laptop) mit einer Netzwerkverbindung zum DxNode Netz, betrieben werden. DxMonitor stellt wie ein 
normaler Netzteilnehmer, eine TCP/IP Verbindung zum ausgewählten Knoten her. 
 
DxMonitor ist für Diagnose und Fehlersuche bei Netzunterhalt und während der Inbetriebsetzung, sowie 
für Integrationstests von Systemanbindungen vorgesehen. DxMonitor kann mehrfach gestartet werden 
um mehrere Knoten oder ausgewählte Verbindungen und Daten in separaten Tabellen zu beobachten. 
 

Weiterführende Dokumente 
DxNode.Net Referenz Manual (DxNode_RefManual_Vxx.x.pdf). Handbuch für Anwender, Ingenieure 
und Techniker, die sich im Bereiche der Automation und Kommunikation auskennen. 
 
DxNode.Net XML-Schema (DxCnfLogAll_Schema.pdf). Beschreibung des Schemas (DxCnfLogAll.xsd), 
das alle Konfigurations- und Monitor Log-Dateien sowie Daten- und Subskriptions-Telegramme definiert. 
Die Schema-Datei DxCnfLogAll.xsd ist für die Telegrammüberprüfung mit DxMonitor erforderlich. 
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Programmbedienung 
Programmstart 
Das Programm wird durch ausführen der Datei DxMonitor.exe gestartet. DxMonitor.exe kennt folgende 
Parameter: 
 

DxMonitor.exe [Konfigurationsdatei] [/lang=xx] 
 

wobei Konfigurationsdatei = Pfad\Dateiname  

xx = Sprache für Bedienoberfläche: de = deutsch, it = italienisch, ohne den Parameter = englisch 

Beispiel: d:\monitor\DxMonitor.exe DxMonconfig01.xml /lang=de 
 
Das Programm wird unabhängig von der Sprache des Betriebssystems, mit deutscher Bedienoberfläche 
gestartet und es wird die Konfigurationsdatei DxMonconfig01.xml, welche sich im gleichen Verzeichnis 
wie DxMonitor.exe befindet, geladen. 
 
Wenn kein Sprachparameter spezifiziert wird, startet DxMonitor mit englischer Bedienoberfläche. Wenn 
DxMonitor in einer, vom Betriebssystem abweichenden Sprache gestartet wird, werden die 
systembasierten Dialoge, wie z.B. Datei>Öffnen… etc. weiterhin in der Systemsprache angezeigt. 
 

Programmkonfiguration 
Der Befehl Datei>Konfigurieren… (File>Properties…) öffnet den nachstehenden Dialog. Unter der 
Rubrik Verbindung (Connect), werden die Parameter für die Netzwerkverbindung zum Knoten definiert. 
 

 
 
 
Parameter Beschreibung Werte 
Host Bestimmt den Rechner, zu dem die 

Verbindung hergestellt werden soll 
IP Adresse oder Netzwerkname des 
Knotenrechners 

Port TCP Portnummer des Knotens 7581 ist das Standardport 
Passwort bzw. 
Password  

Passwort/Kennwort für Datenzugriff via 
oben genanntes Port 

Gleicher Ausdruck (String), wie für das 
entsprechende Port im Knoten festgelegt 
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Unter der Rubrik Monitor, befinden sich die Parameter für die Anzeige-Funktionen. 
 

 
 
 
Parameter Beschreibung Werte 
Client DP's Datenpunktadressen oder -namen für welche 

der Monitor die Client Rolle übernehmen soll 
 

Server DP's Datenpunktadressen oder -namen für welche 
der Monitor die Server Rolle übernehmen soll. 
Diese Datenpunkte werden in der Listenspalte 
Sv mit "S" aufgeführt. 

 

Maske bzw.  
Mask 

Einer oder mehrere Datenpunktadressen oder 
-namen deren Attribute überwacht werden 
sollen 

Voll ausgeschriebe DP Adressen 
bzw. DP Namen werden durch 
Strichpunkte [;] getrennt. 
Eine Gruppe von Datenpunkten 
kann durch Wildcards [* ?] 
spezifiziert werden. 

Lokale Adresse bzw. 
Local Address 

Definiert die Auswahl von DP Adressen in der 
zugehörigen Maske als Benutzerabhängige 
Bezeichnung 

 

Netzwerk Name bzw. 
Network Name 

Definiert die Auswahl von DP Namen in der 
zugehörigen Maske als Netzwerkabhängige 
Bezeichnung 

 

 
Wenn ALLE Datenpunkte mit Wildcard [*] abgefragt werden, bedarf es u.U. sehr viele Ressourcen z.B. 
für eine Tabelle mit 10'000 Datenpunkten und der Rechner wird "langsam" oder schafft die Tabelle gar 
nicht. Es ist daher ratsam mit Wildcards immer nur eine Auswahl der Datenpunkte z.B. mit [A*] oder 
[*.value] abzufragen. 
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Unter der Rubrik Log, befinden sich die Parameter der Logging Funktionen. 
 

 
 
Für eine Beschreibung der Logdateien wird auf das letzte Kapitel Telegrammlogging verwiesen, sowie 
auf DxNode.Net XML-Schema (DxCnfLogAll_Schema.pdf).  
 
Parameter Beschreibung Werte 
Verbindung(en) bzw. 
Connect(s) 

Namen der Verbindungen bzw. Connects 
die geloggt werden sollen. 

Voll ausgeschriebene Namen werden 
durch Strichpunkte [;] getrennt. 
Mehrere Namen können mit Wildcards 
[* ?] spezifiziert werden. Ein Leerfeld 
schliesst sämtliche, auch namenlose 
Verbindungen ein (Node+Daemon). 

Verzeichnis bzw. 
Path 

Verzeichnis in dem die Logdateien 
abgelegt werden. Das Verzeichnis muss 
bereits vorhanden sein, das wird beim 
Verlassen der Rubrik geprüft. 

Das Feld ist editierbar. Mit der Taste 
… wird ein Dialog aufgeschaltet, worin 
man ein Verzeichnis aus dem 
Verzeichnisbaum auswählen kann. 

Dateigrösse bzw. 
File length 

Maximale Länge einer Logdatei, wird 
diese überschritten, wird eine neue 
Datei angelegt. 

Der Defaultwert ist 1024 KB 

Meldungen bzw. 
Telegrams 

In diesem Feld werden die 
Telegrammtypen ausgewählt, welche 
geloggt werden sollen. 

Die Telegramme sind mit ihren XML 
Elementen bezeichnet, z.B. <S0>. 
Siehe auch DxNode.Net XML-Schema 
(DxCnfLogAll_Schema.pdf). 

Alle bzw. All Mit dieser Taste werden alle 
Telegrammtypen ausgewählt. 

 

Keine bzw. None Mit dieser Taste wird die Auswahl aller 
Telegrammtypen gelöscht. 

 

Zeitgesteuertes 
Logging bzw. 
Logging Timer 

Durch Auswahl dieser Checkbox wird die 
Timerfunktion für das Telegammlogging 
aktiviert. Zur Startzeit wird automatisch 
die Verbindung zum Knoten aufgebaut 
und die ausgewählten Telegrammtypen 
werden bis zum Erreichen der Stoppzeit 
aufgezeichnet. 

 

Start Start Datum und Zeit für das 
zeitgesteuerte Logging. 

 

Stop Stop Datum und Zeit für das 
zeitgesteuerte Logging. 
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Parameter Beschreibung Werte 
XML Validierung 
bzw. Validation 

Wenn diese Option eingeschaltet ist, 
werden die zum Logging ausgewählten 
Telegramme zur Laufzeit gegen das 
XML-Schema validiert. 

Die Fehlermeldungen des XML-Parsers 
werden als XML-Kommentar in die 
Logdatei eingetragen. Dabei werden 
zuerst jeweils die Telegrammdaten, 
und nachfolgend allfällige 
Fehlermeldungen eingetragen. 

Log Alle bzw.  
Log All 

Alle Telegramme, auch Fehlerfreie, 
werden geloggt. 

 

Log nur Fehler bzw. 
Log invalid only 

Nur Telegramme mit Validierungsfehler 
werden geloggt. 

 

 
Die Schema-Datei DxCnfLogAll.xsd ist für die Telegrammüberprüfung mit DxMonitor erforderlich, ohne 
diese Datei erfolgt eine Warnungsmeldung beim Starten von DxMonitor: 
 

 
 
Nach drücken der OK Taste wird der Konfigurationsdialog geschlossen und automatisch eine Verbindung 
zum Knoten mit den spezifizierten Parametern erstellt. Wenn bereits eine Verbindung zu einem Knoten 
besteht, wird diese geschlossen und eine neue geöffnet. 
 
Mit dem Befehl Knoten>Verbinden (Node>Connect) wird eine Netzwerkverbindung zum 
Knotenrechner, je nach aktuellem Zustand, geöffnet oder geschlossen. Nach dem schliessen der 
Netzwerkverbindung bleibt der Dateninhalt der Monitortabelle erhalten, bis eine neue Verbindung 
geöffnet wird. 
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Die Monitortabelle 
In der Monitortabelle werden die Attributwerte der Datenpunkte in Echtzeit angezeigt. In jeder Spalte 
wird der Wert eines Attributes dargestellt. Eine Zeile umfasst alle veränderbaren Attributwerte eines 
Datenpunktes.  
 

 
 
Für eine Beschreibung der Standardattribute eines Datenpunktes, wird auf das DxNode.Net Referenz 
Manual (DxNode_RefManual_Vxx.x.pdf) verwiesen. Die Tabelle enthält jedoch zusätzlich die von 
DxMonitor selbst erzeugten Spalten Sv (Server) und Änd. (Änderungen) bzw. Chng (Changes): 
 
Name Beschreibung Werte 
Lokale Adresse bzw. 
(Local Address) 

DP-Adresse in der lokalen Applikation 
RefManual: a="Address (application)" 

String Format gemäss XML Schema 

Netzwerkname bzw. 
(Network Name) 

DP-Name im Netzwerk  
RefManual: n="Name (network)"  

String Format gemäss XML Schema 

Sv (Server) Datenpunkt für den der Monitor die 
Rolle des Servers spielt 

S wenn der Monitor Server ist, oder 
leer wenn der Monitor Client ist 

Änd. (Änderungen) bzw.  
Chng (Changes) 

Anzahl Wertetelegramme** übermittelt 
seit dem Verbindungsaufbau 

Der Wert wird bei Empfang jedes 
Wertetelegramms** inkrementiert  

Wert bzw. Value RefManual: v="Value"  Beliebiger Wert oder String 
Qualität bzw. Quality RefManual: q="Quality"  b..=bad, g..=good, u..=uncertain, 

Default = bWD (Waiting for Data) 
Status RefManual: s="Status and Bit Filter"  0..255, Default = 0 
Zeitstempel bzw. 
Timestamp 

RefManual: t="Timestamp" in [ms] 
UTC (Universal Time Coordinated) 

YYYY-MM-DDThh:mm:ss.xxx [ms], 
Default = 1970-01-01T00:00:00 

Zeitstempelkorr. bzw. 
Timestamp Corrective 

RefManual: tc="Timestamp Corrective"  -2147483648..+2147483647 [ms] 

Einheit bzw.  
Engineering Unit 

RefManual: u="Engineering Unit"  String gemäss XML Schema 
(1/s, mA, MHz, m3/h, kWh, etc.) 

Typ bzw.  
Format and Datatype 

RefManual: f="Format and Datatype"  String gemäss XML Schema 
(Format Specifier %s.., %f.., etc.) 

Index RefManual: i="Index"  -2147483648..+2147483647 
Text  RefManual: x="Text Information" Beliebiger String 
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**Normalerweise wird ein Wertetelegramm nur übermittelt wenn sich ein Attribut verändert hat (Ereignis 
orientiert). Eine Applikation kann jedoch auch Daten als Ereignis verschicken, wenn sich die Werte nicht 
verändert haben z.B. als Trigger oder beim Synchronisieren. 
 

Tabelle sortieren 

Die Spaltenüberschriften sind als Tasten ausgeführt. Ein linker Mausklick auf eine Spaltenüberschrift, 
sortiert die ganze Tabelle in aufsteigender Reihenfolge, nach dem Inhalt dieser Spalte. 
 

Zeilen in der Tabelle selektieren 

In der Tabelle können einzelne Zeilen mit CTRL und linkem Mausklick, ein zusammenhängender Block mit 
SHIFT und linkem Mausklick selektiert bzw. deselektiert werden. 
 

 
 

Kontextmenu 

Ein rechter Mausklick in der Tabelle, schaltet das Kontextmenu auf, welches diverse Funktionen anbietet, 
die auf die selektierten Zeilen ausgeführt werden können. Diese Funktionen werden weiter unten 
beschrieben. 
 

Teil- und Vollansicht 

Die Monitortabelle bietet zwei verschiedene Anzeigemodi. In der Vollansicht werden alle Datenpunkte 
angezeigt, die in den Verbindungsparametern mit Hilfe der Masken beschrieben sind.  Wenn jetzt eine 
Maske z.B. mit [*] angegeben wird, enthält die Monitortabelle alle Datenpunkte die der Knoten im 
jeweiligen Namensraum kennt. Dies kann eine sehr grosse Anzahl sein und der Umgang mit der langen 
Tabelle wird etwas unhandlich. 
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In der Teilansicht werden nur die Zeilen angezeigt, welche in der Vollansicht speziell dafür ausgewählt 
wurden. Dazu werden die betreffenden Zeilen zuerst selektiert und dann mit dem Befehl 
Elemente>Auswahl>Hinzufügen (Items>Selected List>Add) oder mit dem Tastensymbol � in die 
Teilansicht übernommen. Die in der Teilansicht sichtbaren Zeilen, erhalten am Zeilenanfang ein 
Hakensymbol. Mit dem Befehl Elemente>Auswahl>Entfernen (Items>Selected List>Remove) oder 
mit dem Tastensymbol � werden selektierte Zeilen aus der Teilansicht entfernt und der Haken am 
Zeilenbeginn gelöscht. Mit dem Befehl Elemente>Auswahl>Anzeigen (Items>Selected List>View 
List) oder mit dem Lupensymbol kann die Tabelle zwischen Teil- und Vollansicht umgeschaltet werden. 
 

Werte schreiben 

Um Attributwerte im Knoten zu ändern, werden in der Monitortabelle zuerst ein oder mehrere Elemente 
selektiert, und dann wird mit dem Befehl Elemente>Schreiben… (Items>Write…) der Schreibdialog 
aufgeschaltet. 
 

 

Im Schreibdialog können alle editierbaren Attributwerte 
geändert werden. Die Elementnamen sind fix und 
können nicht geändert werden. Wenn der Dialog 
aufgeschaltet wird, werden die aktuellen Attributwerte 
angezeigt.  
 
Wenn in der Monitortabelle mehrere Elemente selektiert 
wurden, werden die Daten des ersten Elementes 
angezeigt. Die Änderungen werden jedoch für alle 
selektierten Elemente vorgenommen. 
 
 

 

Spaltenauswahl 

Um die Tabelle übersichtlicher gestalten zu können, hat der Benutzer hat die Möglichkeit Spalten einzeln 
ein oder auszublenden. Mit dem Befehl Ansicht>Spaltenauswahl… (View>Select Columns…) wird der 
Auswahl Dialog aufgeschaltet. 
 

 

In diesem Dialog werden alle Spalten markiert, die in 
der Tabelle angezeigt werden sollen. Die Lokale 
Adresse (erste Spalte ganz links) kann nicht 
ausgeblendet werden, sie wird immer angezeigt. 
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Statuszeile 
In der Statuszeile werden Verbindungsabhängige Informationen von allgemeinem Interesse dargestellt. 
Die Hintergrundfarbe der Statuszeile zeigt den Zustand der Verbindung zum Knoten:  
 

Offline (neutral) 

Online (grün) 

 Unterbruch (gelb) 
       

Aktuelle Aktion      

VE = Validation Errors 
Anzahl XML Validierungsfehler 
während der aktuellen Sitzung 

     

Hostname oder IP Adresse  
und Portnummer 

des Knotenrechners 

    

Verbindungsstatus CON = Connected 
wenn verbunden, sonst leer 

   

Anzahl Datenpunkte in der Vollansicht   

 
Die Statuszeile wird mit dem Befehl Ansicht>Symbolleiste (View>Status Bar) ein- bzw. ausgeblendet. 
 

Konfiguration und Dateninhalt speichern 
Es besteht die Möglichkeit die Konfiguration des Monitors und die Dateninhalte der Monitortabelle in einer 
Datei zu speichern. Es ist praktisch, Konfigurationsdaten wie Verbindungsparameter, Spaltenauswahl etc. 
für eine nächste Sitzung aus einer Datei zu laden, statt sie jedes Mal neu eingeben zu müssen. 
 
Beim öffnen einer Datei werden auch die gespeicherten Tabellendaten in die Tabelle geladen. Dadurch ist 
es möglich eine Momentaufnahme der Tabellendaten abzuspeichern um sie später offline analysieren zu 
können. Sobald eine Netzwerkverbindung zum Knoten geöffnet wird, werden die Daten in der Tabelle von 
den aktuellen Daten des Knotens überschrieben. 
 
Die Befehle zum speichern und öffnen der Datei entsprechen dem Windows Standard und befinden sich 
wie bei den meisten Applikationen im Menupunkt Datei (File). 
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Telegrammlogging 
Mit dem DxMonitor lassen sich Telegramme <X0> von beliebigen Verbindungen online aufzeichnen und 
mit dem XML-Schema überprüfen, dabei ist wählbar ob nur fehlerhafte oder alle Telegramme in die Log-
Datei aufgezeichnet werden. Bemerkung: File Transfer Meldungen werden nicht aufgezeichnet, diese 
haben nur einen Header in XML, die übertragenen Daten können von jedem Dateityp sein. 
 
Die Telegramme <X0> zum/vom Knoten werden zur Anzeige in der Log-Datei mit umhüllenden 
Elementen <R0> für "Receive" bzw. <S0> für "Send" dargestellt. Nur die Telegramme zum/vom Monitor 
selbst werden mit <X0> für "Read" bzw. <Y0> für "Write" ausgegeben. Für Anbindungen gelten nur die 
Telegramme <X0> (siehe auch umseitig).  
 
Ein Befehl <Y0> vom DxMonitor an DxNode wird somit wie andere, von DxNode empfangene 
Telegramme <X0>, als <R0> aufgezeichnet. Eine Rückmeldung <X0> von DxNode an DxMonitor wird 
wie andere, von DxNode gesendete Telegramme <X0>, als <S0> aufgezeichnet. 
 

 

DxMonitor direkte Empfang/Sende Telegramme 
• <X0> DxMonitor Read Transmission from DxNode 
• <Y0> DxMonitor Write Command to DxNode  

(<X0> gleicher Aufbau wie <X0>) 
 
DxNode Data Transmission Telegramme  
eingehüllt in Log-Dateien zur Kennung mit ... 
• <S0> DxNode Send Telegramm <X0> 
• <R0> DxNode Receive Telegramm <X0> 
 
DxNode Error Level 1..4 nur in Log-Dateien 
• <E1> DxNode Failure Message 
• <E1> DxNode Warning Message 
• <E1> DxNode Information Message 
 
 
 
DxNode File Transfer Message Header 
• <F0> File Request 
• <F1> File Feedback 
 
 
DxNode Konfiguration Parameter-Ausgabe in Log-Datei 
• <Node> Attributes 

 
Siehe auch Beschreibung des XML-Schemas DxNode.Net XML-Schema (DxCnfLogAll_Schema.pdf), das 
alle Konfigurations- und Monitor Log-Dateien sowie Daten- und Subskriptions-Telegramme definiert. 
 

Logdateien 
Die Dateninhalte der Telegramme werden im XML Format in Textdateien gespeichert. Die Logdateien 
können wahlweise mit einem beliebigen Text- oder XML-Editor, oder auch mit dem Internetexplorer 
geöffnet werden. Der Name der Logdateien wird von DxMonitor automatisch nach folgendem Muster 
erzeugt: 
 
DxLog_<Hostname>_<Zeitstempel>.xml 
 
<Hostname> Host-Eintrag aus der Verbindungskonfiguration 
<Zeitstempel> <Jahr><Monat><Tag>T<Stunde><Minute><Sekunde><Millisekunde> 

Der Zeitstempel wird in UTC Zeit angegeben und ist somit unabhängig von der im 
Betriebssystem eingestellten Zeitzone. 

 

Für Attribut Info siehe 
DxCnfLogAll_Schema.htm 

oder Referenz Manual 
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Die folgenden Beispiele zeigen die unterschiedlichen Darstellungsarten mit den verschiedenen Tools. 
 

 

Texteditor 

 

XML-Notepad 

 

Internet Explorer 
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Wenn die parametrierte maximale Länge der Datei erreicht ist, wird diese geschlossen und eine neue 
erzeugt, worin das Logging fortgesetzt wird. In je einer Kommentarzeile wird der Name der 
vorhergehenden bzw. nachfolgenden Datei angegeben. 
 
Bei laufendem Logging schreibt DxMonitor beim empfangen von Telegrammen, in die jeweils neuste 
Datei. Wenn diese Datei nun gleichzeitig in einem Editor zur Ansicht geöffnet ist, kann es zu 
Zugriffskollisionen kommen. Wenn das passiert, beendet DxMonitor die seine Loggingfunktion und gibt in 
einem Fenster eine entsprechende Meldung für den Benutzer aus. Das Logging wird wieder gestartet, 
wenn die Verbindung zum Knoten geschlossen und wieder geöffnet wird. Beim öffnen der Datei mit 
einem XML Editor wird es zu Fehlermeldungen kommen, weil gewisse XML Elemente erst abgeschlossen 
werden, wenn eine nachfolgende Datei geöffnet, oder das Logging gestoppt wird. 
 
 


